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Introduction 
ToolWare Version 3 is the software package designed for communicating with AcraDyne DC Electric Tool 
Controllers. 
 
ToolWare provides an easy-to-use, Windows-based platform that can be used for: 
 
■ Tightening strategy programming  ■ Maintenance and calibration alert programming 
■ Collection and viewing of rundown data ■ Controller configuration programming 
■ Statistical analysis ■ Tool calibration 
■ Rundown curve analysis ■ Batch programming 
■ I/O monitoring and configuration ■ Network communication configuration  

 
This version of ToolWare is designed to be fully compatible with all iEC series AcraDyne Tool Controllers 
and the iControl AcraDyne Tool Systems.  In addition, this software compliments and enhances features 
and benefits of AcraDyne 1000, 2000, 3000 and 8000 (HT) series tools that are connected to and used 
with AcraDyne controllers. 
 
While past versions of AcraDyne’s ToolWare software have been completely backwards compatible, 
version 2.1.0.0 marks the first version that is no longer compatible with the discontinued Evolution series 
controllers.  Should you require software to run the older Evolution or iControl controllers, please visit 
www.aimco-global.com and look to the “Downloads” tab.  There you will find older versions of ToolWare 
that will function with the Evolution or iControl controllers and are downloadable free of charge. 
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1. Getting Started with ToolWare 
1.1 Terminology and Abbreviations 

Terminology and abbreviations used in this manual are described in the table 
below. 
Table 1.1 Terminology and Abbreviations  

Term/Abbreviation Explanation 
Tool AcraDyne Nut runners including Pistol, Straight and Tubenut 

wrench 
Controller AcraDyne iEC Controller  
CIM Controller Interface Module is an adapter between the 

Controller CAN bus and PC USB port 
Rundown A complete tightening cycle 
SCC Spindle Control Card 
CNC Communications Network Card 
Gen 1 Tool with Light Ring 
Gen 3 / 4 Tool with Multi-Function Button (MFB) 

1.2 Introduction to ToolWare  

1.2.1 About this document 
This document is a manual for using ToolWare software. It consists of three 
parts: 
Chapter 1: “Getting Started with ToolWare” introduces the software and gives 

step-by-step instructions on using it to run AcraDyne tools. 
Chapter 2: “Working with ToolWare” gives detailed explanation of the 

software features and functions. 
Chapter 3: “Addendum” provides reference information needed for 

troubleshooting and general knowledge. 

1.2.2 ToolWare Overview 
ToolWare is a software program designed for configuring AcraDyne electric 
tools and controllers directly from PC for threaded assembly applications. 
The ToolWare version in use must be compatible with the firmware of the 
Controller which consists of DSP firmware and CNC (Communication 
Network Card) firmware. 

 
ToolWare compatibility with Torque Tool Controller Firmware 

ToolWare Version Compatible Firmware Release 
DSP CNC card 

3.x.x.x 3.x.x       6.xx 
 

Note. If you wish to update your controller software, please contact your 
AIMCO sales representative.  
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1.3 ToolWare Installation  

1.3.1 PC Requirements 
ToolWare requires a PC with 1GB or higher RAM and Windows XP or later 
version OS.  
 

1.3.2 Installing ToolWare 
To install ToolWare: 
• Insert the installation CD and installation will start automatically. You can 

also manually start it by double clicking on “Setup.exe”.  
• Follow instructions on screen to complete installation. 
• User should have Administrative Privileges to install ToolWare.  

 
 It is recommended to have your ToolWare CD files or Download files stored 
on your Hard Drive.  
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1.4 Introduction to ToolWare User Interface 
 

When ToolWare is initially opened, the selection box shown in Figure 1.4.1 will 
appear, if not connected to the controller.   
 

 
 

Figure 1.4.1 Dialog box for selection of controller platform being used  
 
The ToolWare interface is similar to the workspace of most MS Windows 
applications. Figure 1.4.2 shows the main screen and structure consisting of 
two menu bars. 

 

 
Figure 1.4.2 Main Screen of ToolWare 
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1.4.1 ToolWare Menu Structure 
 

 
 

 

Menu Level Supported Functionality 

File 

Connection Establish Connection with the Controller 
Open Open a file 
Save Save a file 
Print Prints screen graphic or data file 

LogIn Login to the program to access appropriate menu 
items 

LANGUAGE Switch Language Locale 

LogOff Program remains open, some menu items not 
accessible 

Exit Close the program 

Controller 

View Firmware Rev. Returns controller’s Servo & firmware version 
Edit Configuration Parameters Modify controller configuration 
View / Edit  Date/Time Set the date & time in the Controller 
Reset Controller to Defaults Restore factory values of controller parameters 

Tool 

View 

Tool Parameters View tool parameters 
Torque Cal Value View the tool calibration value 
RPM’s View tool output drive rotations / minute 
Cycle Count View number of cycles run by tool 
Motor Temp View motor temp from tool 

Edit Tool Setup Set up tool parameters 

Calibrate 

Torque Calibrate the tool to a master transducer 
Buttons and LED’s Program and test buttons and LED’s 
Service and Calibration 
Log Set alerts for tool service and calibration  

Rundowns Display rundown data in a tabular format 
Log Info Usage View tool and controller usage information 

Statistics Performs statistical analysis of a previously saved 
rundown-data file 

AcraVision Displays real-time rundown information in full-
screen view 

System 
Serial Test Used for testing of serial data string information. 

Fault Codes Displays a list of fault codes for the controller and 
tool. 

Main 
Functions 

 

Parameter Sets Opens the parameter set programming window. 
CurveWare Displays rundown graphs for analysis 

Statistics Performs statistical analysis of a previously saved 
rundown-data file 

Monitor I/O Displays the status of I/O signals 

Fault Codes Displays a list of fault codes of the controller and 
tool. 

Help About ToolWare Displays the latest version of the ToolWare. 
ToolWare Help Opens a PDF Help file 
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1.4.2 Lower Menu Bar 
Lower Menu Bar is a shortcut to the frequently used Upper Menu items 

located under <Main Functions> submenu. These frequently used functions 
include: 
• Parameter Sets 
• CurveWare 
• Monitor I/O 

 

1.4.3 Status Bar 
Status Bar is combined with the Lower Menu Bar. Information displayed 

on the status bar is listed in the Table 1.4.3 
 

   Table 1.4.3  Status Bar Contents 
Status Item Display Options 

Torque Units 

N*m 
Lbs*ft 
Lbs*in 
KgCm 
KgM 

Connection 
Offline 
USB 
Ethernet 

 
 



 10 

1.5  Connecting IEC Controller with PC 
ToolWare supports –2 options of connecting Controller to PC depending on the 
interface and the model of AcraDyne Controller: 
• USB port through the CIM adapter (P/N # AEC-CIM) 
• Ethernet port through the Ethernet crossover cable or standard cable 
 
Figure 1.5.1 and Figure 1.5.2 show the Communication / Connection interface 
panels of iEC Controller. 
 
      

 
         Figure 1.5.1 iEC Controller Bottom panel             

 
 
 
 
 
 
 
 
 
 
 

 USB 
Cable CIM 

Custom 
Cable 

 I/O Port 
8in/8out 

RS232 

Future Use 

KDM/ 
Factory Use 

CAN 
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Figure 1.5.2  iEC controller electrical interface, top panel (Some connections 
available on iEC3 and iEC4 models only  

RJ45 CAT 5E 
Regular Cable 
Straight 
through pin out 

Ethernet Port1 

Ethernet Port2 
 

COM1 
RS232 
 
 

Tool Cable 

COM2 
Bar Code Scanner 
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1.5.1 Connecting to USB port 

 
 

1.5.2 Connecting to Ethernet Port 

 
 
 

1.5.3 Connecting to the network 

 
 
 
 

2. Working with ToolWare 
2.1 Connecting PC with the Controller 

2.1.1 Setting up USB Connection 
Follow the steps below to set up USB connection. 
• Turn on the computer.  
• Plug the USB cable (PN: 22940) into your computer’s USB Port or USB 

Hub and the other end to the CIM Module (PN: 23112).  
• Plug the 23217 cable into the connector on the CIM and the other end of 

the cable to either of the CAN ports in the controller.  

IEC 
 Controller  

 
Ethernet port 

Network 
Router 

 
Ethernet port 

Cable 
PN: 20403 
 
 
 
RJ45 CAT5E 

RJ45 cable 
/cross over  
 
 

IEC 
 Controller  

 
Ethernet port 

PC 
 

 
Ethernet port 

IEC 
Controller  

 
CAN port 

PC 
 

 
USB port 

AEC-CIM 
P/N 23112 
(Includes P/N 
23217/22940) 

Cable 
PN: 22940 
 

Cable 
PN: 23217 
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• Launch ToolWare and configure it for USB connection by selecting 
File/Connection/USB. 

2.1.2 Setting up Ethernet Connection 
Make physical connection 
Connection options: 
• Use Ethernet crossover or standard cable to connect Controller to PC 

directly. 
• Use Ethernet crossover or standard cable to connect Controller to network 

router. 
 
Specify the IP Address of controller in the PC 
• Open Control Panel by clicking <Start/Settings/Control Panel>.  
• Select <Network Connections> for configuration.  
• Double click <Local Area Connection> to open its Status Window.  
• Click on <Properties> button to open Properties Window.  
• Scroll the list of connections to find <Internet Protocol (TCP/IP)> and 

double click it to open Internet Protocol Properties window.  
• Click on <Use the following IP address>  and enter the IP address of 

10.10.30.155  
• Set the subnet mask to 255.255.255.0.  
• Click on <OK> button to exit <Internet Protocol Properties> window.  
• Click on <OK> button to exit <Local Area Connection Area Properties> 

window.  
• Click on <OK> button to exit <Local Area Connection Area Status> 

window.  
• Exit <Control Panel> window.  
 
Configure ToolWare for connection with PC:  
• Launch ToolWare program.  
• Click on <File/Connection/TCP/IP> to open <TCP/IP Connection Setup> 

window. 
• Specify IP address of controller (10.10.30.150 by default) 
• Click on <Connect> button to establish connection. 
• Verify communication by reading DSP firmware version: 
 Select <DSP/View/Revision>;  
 Verify the DSP firmware version returned successfully. 
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Successful Connection 
 A successful Ethernet connection will be indicated by the following text on the 
main screen of the ToolWare program: 
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2.2 Setting Parameters 
In ToolWare, select <Main Functions/Parameter Sets> from the top menu or 
select <Parameter Sets> directly from the lower menu to open <Parameter 
Sets View/Edit> window shown in the Figure 2.2. ToolWare can send and 
receive up to 32 Parameter sets to the controller.  
 
 
 

 
 
Figure 2.2 Parameter Sets View/Edit Window 
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2.2.1 Parameter Entry Fields 
Strategy - Select one of four fastening strategy options. 
o Tc - Torque Control strategy uses torque as the only control parameter. 

The Tool stops when Tq Target is reached. Rundown is considered to be 
successful (Accept) if the final torque value falls within the range specified 
by Tq High Limit and Tq Low Limit parameters. 

o Tc-Am - Torque Control/Angle Monitoring strategy is convenient for 
detection of cross threaded or stripped fasteners. Rundown is considered 
to be successful (Accept) if the final torque value falls within the range 
specified by Tq High Limit and Tq Low Limit and final angle value falls 
within the range specified by Angle High Limit and Angle Low Limit 
parameters. 

o Tm-Ac - Torque Monitoring / Angle Control strategy. The tool stops 
when Angle Target is reached or Tq High Limit is exceeded. Rundown is 
considered to be successful (Accept) if the final torque value falls within 
the range specified by torque upper and lower limits. 

o Tc-Ac - Torque Control / Angle Control strategy. The tool stops if target 
torque or target angle is reached, whichever happens first. Rundown is 
considered to be successful (Accept) if both the final torque value and final 
angle value fall within their respective high and low limits. 

 
Direction - defines fastening direction. It should be clock-wise (CW) for right-
threaded fasteners and counter-clock-wise (CCW) for left-threaded fasteners. 
 
Tq High Limit - used for Accept / Reject decision. Rundown does not pass if 
the measured torque exceeds this limit. 
 
Tq Target - the target torque value. 
 
Tq Low Limit - used for Accept / Reject decision. Rundown does not pass if 
the torque measured at the end of rundown is below this limit. 
 
Tq ± % - high and low torque limits are automatically and symmetrically set 
around the target value. 
 
Tq Downshift - the torque value at which the tool changes the speed from 
Freespeed RPM to Downshift RPM, in order to provide better accuracy of a 
final torque 
 
Tq Threshold - specifies torque threshold value as a start point for the 
rundown cycle data acquisition. 
 
Cycle Complete - the torque value that defines the completion of a fastening 
cycle. The cycle is complete if, after rising above the Tq Threshold value, 
torque drops below the Cycle Complete value. 
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Angle High Limit - is used for Accept / Reject decision. Rundown does not 
pass if the measured final angle exceeds this limit. 

            
Angle Target - the target angle value 

 
Angle Low Limit - used for Accept / Reject decision. Rundown does not pass 
if the final angle is below this limit. 
 
Rpm Freespeed % - specifies initial tool output-drive speed. The parameter 
is expressed as a percentage of the tool’s maximum rated speed. 
 
Rpm Downshift % - specifies the speed of the tool after the Tq Downshift 
value is reached. The value is expressed as a percentage of the tool‘s 
maximum rated speed. 
 
Ergo Mode - activates tool power ramping-down mode when fastening 
achieves Target Torque or Target Angle value. This feature reduces torque 
reaction in the hand-held tool as final torque or angle is achieved. 
  
Soft Start - activates tool power ramping-up from zero to Rpm Freespeed% 
value.  This allows for slower engagement of the fastener into the application. 
 
Linked PSets – creates a group of sequential Parameter Sets actuated by a 
single trigger pull.  To define the last Parameter Set in the group, unselect 
“Link PSet” by placing a 0 in the field. 
 
Link Delay - used to add a delay time between the linked steps. 
 
Running a Linked PSet rundown: 

 
• To run a Linked PSet group, select the first PSet in the group as the 

“Current PSet”. (Via the CHANGE PSET button on the controller, or 
using Logic IO, or using the “Current” PSet selection in Toolware)  

• Link the PSets by selecting the next PSet in the Current PSet’s “Link 
PSet” Drop down. If you want to have a delay between the rundowns 
enter that in   the “Link Delay” Drop Down box.  If you want to link more 
PSets then repeat this step.  

• Run the tool as usual by pressing and holding the throttle.  
• The tool will sequence thru each PSet in the Linked PSet group.  
• At the completion of last the PSet of the group, the controller will 

signify the Linked PSet rundown is complete by lighting the cycle 
accept (or reject) led and turning off the blue In-cycle led. 

• The current PSet will automatically reset to the first PSet in the group 
to ready for the next rundown.  

• A release and repress of the trigger is necessary to start the next 
Linked PSet rundown. 
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           Linked PSet Results Reporting: 
 

The angle count is reset to 0 at the end of each linked step of a Linked PSet 
rundown.  

 
RBR Combined with a Linked PSet Rundown Note: 
 
The RBR, RB, and RBsp, options are only preformed at the end of the last 
step of a Linked PSet rundown 

 
Results Reporting: 

 
The results of the last PSet Step in the group are used to report. 
 
If the trigger is released before the rundown sequence is complete, the results 
from the step that the controller was currently running, before being 
interrupted, are reported. 
 
The controller reports curve data from the last rundown step and any linked 
previous steps if not separated by a delay time. 
 
Batch Processing: 
 
ToolWare allows the user to specify PSets for the sequence of rundowns. 
During the batch process the controller monitors each rundown and switches 
PSets automatically. We can control the actions of the controller as each step 
in the batch is completed. When PSets are linked only the last PSet has batch 
settings.  
 
 
Count Preset – defines the number of accepted (ACCEPT) rundowns that 
must be completed for the associated parameter set 
 
Action At Preset Count Complete - The choice of options for end-of-batch 
events is: 

 Act1 - Reset count and output batch complete 
 Act2 - Hold count and output batch complete 
 Act3 - Disable tool – Hold count and output batch complete 
 Act4 - Go to next PSet & do not output batch complete 
 Act5 - Go to next PSet and output batch complete 

 
Next PSet – determines the parameter set that is automatically activated 
when the count for the associated PSet is reached 
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2.2.2 Parameter Sets 
 
Parameter Enable - check boxes allow the user to generate up to 32 different 
sets of parameters. Each set can be used individually or sets can be arranged 
into batch sequence. If the box is unchecked and the parameters are sent to the 
controller it deletes the parameter set. 
  
Copy - button allows the user to copy one set of parameters into another. The 
user must specify the destination parameter set number. 
 
Delete - removes parameter from overall set. 
  
Receive - downloads parameters from the iEC Controller to PC. Downloaded 
parameters are displayed but not saved in the PC. 
 
Send - uploads the current parameters from ToolWare to the controller.  The 
controller will automatically switch to Parameter Set #1 after all parameter sets 
have been loaded. 
 
New - allows the user to create a new set of parameters, regardless of what set 
is selected as currently active in the Controller or in the ToolWare. 
 
Open - opens a saved Parameter file stored in the computer and displays it in the 
ToolWare Screen.  Parameter set must be SENT to the controller to be used. 
  
Save - saves the parameter sets displayed on the ToolWare screen as a file to a 
designated location on the computer. 
  
Reset to Factory Defaults - resets the controller’s parameters to the factory 
settings. 

• If Reset To Factory Defaults is selected while tool is connected to 
controller, three parameter sets will be configured at 30%, 40% and 
60% of the tool’s maximum rated torque 

• If Reset To Factory Defaults is selected while tool is disconnected 
from controller, eight parameters sets will be configured at 10 Nm, 
20Nm, 30 Nm, 40 Nm, 50 Nm 60 Nm, 70 Nm and 80 Nm 

 
Change units - changes the torque units in the ToolWare. Select SEND to 
change units in the Controller also. 
 
Convert Units in Controller and ToolWare - if checked, automatically converts 
units in controller and ToolWare to new units when new unit of measurement is 
selected. 
 
If Rundown-Backoff-Rundown or Low Speed Control are active in the 
controller, User will be notified on this screen.  
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2.3 CurveWare 
In ToolWare, select <Main Functions/CurveWare> from the top menu or select 
<CurveWare> directly from the lower menu to open <CurveWare> window shown in the 
Figure 2.3. Only rundown information after most recent Power On of the controller can 
be graphed. 
  

 
Figure 2.3 CurveWare example 
 
 
Max Torque - is the upper torque limit of the rundown 
 
Max Angle - is the upper angle limit of the rundown 
 
No. of Data Points - is the number of data points that should be used in the plot. 
Maximal number of acquired data points is 4000. 
 
Current Plot - the Nth rundown that has been recorded is highlighted in the graph.  
 
Receive – downloads last rundown data from the Controller. 
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Save - saves data points of all curves in the plot in ASCII file. 
 
Remove - removes the currently selected plot from the graph. 
 
Receive/View - Receive/View allows the user to choose the display features of the 
graph.  
Torque – downloads and displays torque data points. 
Angle – downloads and displays angle data points.  
PSet - displays markers indicating parameter set values.  
View Controls  

Pan - reposition the view in the drawing area. 
Pan/Zoom – change magnification.  
View All – return to the original dimensions. 
Show All Plots - displays all the plots.  

 
Cursor mode - restricts cursor locations to curve data points. 
 
Plot Axis - allows user to choose between Torque/Angle Vs Time and Torque Vs 
Angle.  The axes of the graph will change accordingly. 
 
Plot Name – allows the user to rename the plot.  By default, the plot name is formed by 
using the date and time at which the plot was created. 
 

CurveWare allows for 10 sequential curves to be overlaid upon each other for 
analysis purposes. 

 
 

2.4 Monitoring I/O 
In ToolWare, select <Main Functions/Monitor I/O> from the top menu or select <Monitor 
I/O> directly from the lower menu to open <Monitor I/O> window shown in the Figure 
2.4. 
 
The I/O function is only available in iEC2, iEC3 and iEC4 models.  A connector kit is 
available from AIMCO that allows the user to connect and route wiring to a variety of 
devices, including light-towers, socket trays, audible signals and PLC modules.   The 
part number is #23490.  Contact your AIMCO representative for this item.  
 
This screen allows the user to activate and display the operation of the input and output 
signals to the controller.  Off Delays of outputs in this screen and send it to the 
controller or receive the same from the controller. For testing and setting purposes the 
physical outputs and logical inputs can be forced ON/OFF temporally. This screen also 
shows the state of the physical I/O. We can temporally change the control source 
between Tool buttons and Logic I/O port. 
Selection of PSets through IO is limited to PSets 1-8.  Selection of entire 32 PSets 
library requires network connectivity. 
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Figure 2.4 Monitor I/O screen 
 
Off Delay - specifies how long the output signal will be ON before turning OFF. Each of 
the 8 input fields corresponds to the output field. Example: If 200 is the value in the first 
field that the output signal for Accept will be ON for duration of 200 mSec. If the value is 
0, then the corresponding output will remain ON indefinitely or until the next rundown 
starts. 
 
Control Source – allows user to choose the source that controls the tool operation 

Buttons From Tool – Normal operating condition; tool lever and control ring 
control tool operation 
Buttons From I/O – For testing purposes; allows the tool lever and control ring 
to be over-ridden by buttons on the Monitor I/O screen 

 
Force Enable – When Buttons From I/O is selected, this field selects which inputs and 
outputs can be forced through the Monitor I/O screen 
 
Function/State – When Buttons From I/O is selected and the operation is selected by 
checking Force Enable, clicking on this field will force the respective operation to take 
place, regardless of tool button positions. 
This field will be red when the operation is off and will turn green when the operation is 
on. 
 
I/O Connector Physical States - this diagram is a real time display of the I/O 
connector.  Each position corresponds to the indicated terminal on the 25-pin I/O 
connector on the bottom of the controller. 
 

2.5 File Menu 
In ToolWare, select <File> from the top menu. File Menu enables us to select the 
Connection type with which we want the ToolWare to connect to the Controller.  

2.5.1 Connection 
This enables the user to specify how ToolWare will connect with and communicate to 
the Controller. The options are as follows: 
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USB - is used if the computer is connected with the controller using the USB connection 
in the computer. 
 
Ethernet - can be selected to set the IP address the connection should use.  
 
Offline mode - gives the user the opportunity to -edit parameter files and configuration 
files to save  without being connected to the controller 
 

2.5.2 Open 
Enables the user to select the file to open 

2.5.3 Save 
Saves the file to the PC in the specified directory 
 

2.5.4 Print 
Print the Screen or the Data.  

2.5.5 Login 
Login is not required for general access, though advanced features are not available 
in this mode.  On occasion, when advanced features need to be accessed, a 
password will be given and can be entered here. 
 
An AcraDyne technician or an AIMCO salesperson can create a temporary password 
to give to a customer.  This password will be valid for the day it is given.  This can be 
used when a customer needs to access technical areas on a temporary basis.  It is 
based on the calendar date and will be valid until midnight of that date. 
 
Contact your AIMCO sales representative to get more information on passwords for 
use with ToolWare. 
 

2.5.6 Language 
User can change language and locale either for the particular session or set it as default 
for the system. The application switches to the language the  User selects.  
 

2.5.7 Logoff 
Log out of the user level the user is in.  
 

2.5.8 Exit  
Exits ToolWare 
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2.6 Controller 

2.6.1 View Firmware Rev  
  Displays the current DSP revision and Servo Rev 

2.6.2 Edit Configuration Parameters 
The user can Edit the controller configuration from this screen.  The screen is 
shown in Figure 2.6.2. 
 

 
Figure 2.6.2 Edit Controller Parameter screen 
 
 
Adaptive Control 
 
Enable - Adaptive control is a useful option when a high CPK (Process 
Capability) is chosen as the most important variable.  This is done by adjusting 
the control to ensure the average applied torque is centered between the upper 
and lower control limit. 
This feature has three options, which are explained below. 
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Off - Turns adaptive control off.  The tool will produce torque until the target 
torque is achieved.  Therefore, all results will be equal to or greater than the 
target. This will cause the average torque to be greater than the target torque, 
thus making it extremely difficult to produce a high CPK. 
First Ten - Takes an average of the first ten readings in a new parameter set and 
adjusts the control to make the average torque correspond with the target torque.  
Therefore, there will be readings both above and below the target torque, thus 
maximizing CPK. 
• All - Similar to above, but continually adjusts the control based on the 

average of the previous ten readings in an attempt to maximize CPK. 
 
Pct Adjustment: % Adjustment - Determines how much of a correction 
adaptive control will try to make. The higher the number, the greater the 
correction adaptive control will make. 
 
 
In Cycle Configuration 
At Threshold – the tool status is switched to <In Cycle>  when torque reaches 
torque threshold set point. 
 
At Throttle – the tool status is switched to <In Cycle> immediately when 
rundown is triggered. 
 
Note: In Cycle Configuration “At Throttle” and Rehit Reject are mutually exclusive 
selections. 
 
 
Rehit Reject  
This feature prevents operator from attempting to tighten the fastener that has 
already been tightened. If this feature is enabled, the rundown will stop if the 
angle of rotation between cycle complete and threshold torque is less than a 
specified number of degrees. 

 
Rehit Reject On/Off - If Enabled will abort the attempt to fasten a pre-tightened 
fastener. The default setting for this option is off. 
  
Rehit Reject Angle - Used to determine if a fastener is already tightened.   
If the angles of rotation between cycles complete torque and cycle threshold 
torque is less than the programmed angle, then the fastener is assumed 
tightened and no pass/reject will be reported. 
 
Note: Rehit Reject and In Cycle Configuration “At Throttle” are mutually exclusive 
selections. 
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Rundown-Backoff-Rundown 
This feature includes three modes that engage reverse rotation of the tool. 
 
Enable – activates the feature. There are four options available when the feature 
is enabled. 
 

• Rundown Backoff SP -  Tool will rundown to selected PSet torque, 
reverse the fastener a set number of degrees defined by Back Off 
Degrees.  Reports the Torque and Angle from the rundown. 
 

• Rundown-Backoff-Rundown – Rundown to the 1st Rundown torque 
(specified below) then reverse the fastener a set number of degrees and 
re-tighten the fastener to the target torque established in the parameter 
set.  Reports the Torque and Angle at end of cycle. 

 
• Rundown-Backoff - Tool will rundown to 1st Rundown Torque, reverse 

the fastener a set number of degrees. Reports the Torque and Angle at 
end of cycle. 

 
• Off  - Switches the Rundown-Backoff or Rundown-Backoff-Rundown to off 

mode 
 

 
1st Rundown (in-lbs) - The initial rundown torque, measured in (in-lbs). 
 
Dwell Time before Back Off - Dwell time [ms] between first rundown and the 
start of back off.  
 
Back Off Degree - The amount of rotational degrees the fastener is backed off 
after reaching 1st rundown torque.  
Back Off Torque Limit – This is the backoff torque limit, measured in (in-lbs)  
Dwell Time before Second Rundown - Dwell time [ms] between back off and 
the start of second rundown. 
 
 
 
Soft Start 
  
This feature allows the user to set the speed and timing of how quickly the tool 
ramps up to Freespeed RPM 
 
Dwell (ms) - the amount of time that the tool will rotate at slow speed before 
progressing to the Freespeed RPM (default 500 ms) 
 
Dwell (RPM) - the RPM at which the tool will run during soft start period (default 
90) 
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Ramp (ms) - the amount of time from the end of the soft start period until the tool 
reaches the Freespeed RPM (default 600 ms) 

 
Start Delay 
 
Start Delay On/Off - When enabled, the tool will ignore programmed torque 
parameters until the timer runs out.  This is often used in jobs with prevailing 
torque that exceeds target torque.  The default setting is disabled 
 
Start Delay (ms) - The amount of time at the beginning of the fastening cycle, 
measured in milliseconds, which the tool will ignore programmed torque 
parameters. (default 500 ms) 
 
 
 
 
Time Controls 
 
Free Run Timeout – The amount of time, in seconds, the tool is allowed to run 
free without the load (before reaching cycle threshold).  This is a safety feature in 
case the tool is placed down on the throttle.  The default setting is 5 seconds. 
 
Load Timeout - The amount of time the tool is allowed to run after crossing cycle 
threshold.  The default setting is 15 seconds. 
 
Cycle Complete - The amount of time, in ms, the torque must remain below 
cycle complete before the event is counted as a cycle and the final torque is 
displayed (default 200 ms). 
 
Locked Rotor - Safety feature which shuts off the tool when it has reached a 
stalled condition.  The amount of time, which the tool can remain in a stalled 
condition, is programmed (in milliseconds). The default setting is 100 ms. 
 
Gen 1 Tool Button Configuration 
 
This feature allows the user to program the functionality of the light ring. The 
default setting for this section is  
• CW - Forward;  
• Center - Reverse 
• CCW - Auxiliary 
 
Control Source allows user to choose the source that controls the tool operation  
Buttons from Tool/IO - Determines the source of the Trigger, Forward, Reverse, 
and Aux Commands. 
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Gen3 / 4 Tool Button Configuration 
 
Multi-Function Button (MFB) 

• Tap action: triggered if button held less than hold time.  
• Hold action: triggered if button held to hold time or longer. 
• Hold Time: Amount of time required to hold the MFB until Hold Action is 

triggered. 
• Arming Timeout: Amount of time after the tool is armed, that the tool will 

automatically disarm. 
 

Tap MFB Function Options 
Actions will commence upon release of the MFB button on the tool as 
programmed 

 
• Arming (Tubenut Tool Default):  Tapping MFB button arms (activates) the 

start function but does not start the tool.  Blue status light illuminates to 
indicate tool is Armed.  Arming will reset in 3 seconds if tool start is not 
initiated. 

• Change PSET:  Tapping MFB button toggles between PSET A and PSET 
B.  Status lights flash indicating PSET A is selected or twice if PSET B is 
selected 

• Reset Reject Tone:  Tapping MFB button silences reject tone 
• Tap Disabled:  Tapping MFB button has no effect on tool 

 
Hold MFB Function Options  

Actions will commence after Hold timer preset time has elapsed (Adjustable in 
Hold Time window). Default value is 1 second. 

 
• Arming (Tubenut Tool Default):  Holding MFB button arms (activates) the 

start function but does not start the tool.  Blue status light illuminates to 
indicate tool is Armed.  Arming will reset in 3 seconds if tool start is not 
initiated. 

• Change PSET:  Holding MFB button toggles between PSET A and PSET 
B.  Status lights flash indicating PSET A is selected or twice if PSET B is 
selected 

• Reset Reject Tone:  Holding MFB button silences reject tone 
• Hold Disabled (Default):  Holding MFB button has no effect on tool 

 
Push to Start Operation 

Choices are: 
• Both Push to Start (PTS) and Trigger must be depressed for tool start  
• Either PTS or Trigger may be pressed for tool start (Default) 

 
Control Source allows user to choose the source that controls the tool operation  
Buttons from Tool/IO - Determines the source of the Trigger, Forward, Reverse, 
and Aux Commands. 
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Gen1 Tube Nut 
  
Homing Type -  There are three options 

• No Home 
• Home on release and repress of main trigger 
• Auto Home on release of Main trigger 

  
Tube Nut Back off RPM - The speed, expressed in RPM, which a tube nut tool 
will return to the open position upon release of throttle.  The default setting for 
this is 100 RPM. 
 
Reverse Dwell - The amount of time before the output tries to return to home, 
after the throttle is released (default 500 ms). 
 
Home Dwell - The amount of time that the output is held at home position  
(default 500 ms). 
WARNING: If Latching Throttle is Enabled and Tubenut Homing Option is set to 
“Auto Home on Release of Main Trigger”, the Tubenut will attempt to home 
prematurely. 
 
Gen 4 Tubenut 
 
Multi-Function Button (MFB) 

• Tap action: triggered if button held less than hold time.  
• Hold action: triggered if button held to hold time or longer. 
• Hold Time: Amount of time required to hold the MFB until Hold Action is 

triggered. 
• Arming Timeout: Amount of time after the tool is armed, that the tool will 

automatically disarm. 
 

Tap MFB Function Options 
Actions will commence upon release of the MFB button on the tool as 
programmed 

 
• Home Retry:  Tapping the MFB button puts the tool into homing mode.  All 

LEDs will flash and the horn will beep to signal the tool is in homing mode.  
Pressing the throttle(s) will start the homing move. After the homing is 
complete and the throttle(s) released, the tool will return to fastening 
mode. LEDs and horn will return to the previous state.  ‘Tool disable’ will 
be ignored during the retry homing cycle. 

• Arming (Tubenut Tool Default):  Tapping MFB button arms (activates) the 
start function but does not start the tool.  Blue status light illuminates to 
indicate tool is Armed.  Arming will reset in 3 seconds if tool start is not 
initiated. 

• Change PSET:  Tapping MFB button toggles between PSET A and PSET 
B.  Status lights flash indicating PSET A is selected or twice if PSET B is 
selected 

• Reset Reject Tone:  Tapping MFB button silences reject tone 
• Tap Disabled:  Tapping MFB button has no effect on tool 

 



 30 

Hold MFB Function Options  
Actions will commence after Hold timer preset time has elapsed (Adjustable in 
Hold Time window)  Default value is 1 second. 

 
• Home Retry:  Holding the MFB button puts the tool into homing mode.  All 

LEDs will flash and the horn will beep to signal the tool is in homing mode.  
Pressing the throttle(s) will start the homing move. After the homing is 
complete and the throttle(s) released, the tool will return to fastening 
mode. LEDs and horn will return to the previous state.  ‘Tool disable’ will 
be ignored during the retry homing cycle. 

• Arming (Tubenut Tool Default):  Holding MFB button arms (activates) the 
start function but does not start the tool.  Blue status light illuminates to 
indicate tool is Armed.  Arming will reset in 3 seconds if tool start is not 
initiated. 

• Change PSET:  Holding MFB button toggles between PSET A and PSET 
B.  Status lights flash indicating PSET A is selected or twice if PSET B is 
selected 

• Reset Reject Tone:  Holding MFB button silences reject tone 
• Hold Disabled (Default):  Holding MFB button has no effect on tool 

 
Homing Type -  There are three options 

• No Home 
• Home on release and repress of main trigger 
• Auto Home on release of Main trigger 

  
Tube Nut Back off RPM - The speed, expressed in RPM, which a tube nut tool 
will return to the open position upon release of throttle.  The default setting for 
this is 100 RPM. 
 
Reverse Dwell - The amount of time before the output tries to return to home, 
after the throttle is released (default 500 ms). 
 
Home Dwell - The amount of time that the output is held at home position  
(default 500 ms). 
 
 
Note: If Latching Throttle is Enabled and Tubenut Homing Option is set to “Auto 
Home on Release of Main Trigger” the Tubenut will attempt to home prematurely. 
 
Latching Throttle 
Pull trigger and tool finishes cycle automatically. 
A second trigger tap stops tool. 
Tool will unlatch automatically at the end of the rundown. 
 
Latching Throttle Options: 

• Latch by Using the MFB Option 
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1. Press and hold trigger 
2. Press and hold MFB 
3. Release trigger 
4. Release MFB 

• Press and Hold Option 
1. Hold trigger down for x seconds to latch throttle. 

• No Latch Option (Default) 
 
 
Serial Output Format 
 
This function allows the user to select the format of the information in the ASCII 
character string packet that is sent out of the controller via the RS232 Port.   

 
a) Standard Output: 
 
Format: 
 
O P HHHHH LLLLL TTTTT P HHHHH LLLLL AAAAA CR CR  
 
O: Overall Pass/Fail  
P: Tq Pass/Fail  
HHHHH: Tq High Limit  
LLLLL: Tq Low Limit  
TTTTT: Tq Result  
P: Angle Pass/Fail  
HHHHH: Angle High Limit  
LLLLL: Angle Low Limit  
AAAAA: Angle Result  
CR  
CR 
 
b) Profibus Output:  
 
Format: 
 
%CAN 1 O P HHHHH LLLLL TTTTT P HHHHH LLLLL AAAAA NAC% 
CRLF 
 
%CAN: Msg Start 
1:  PSet ( “1” – “9”) for PSets 1-9, (“A” – “W”) for PSets 10-32 
O:  Overall Pass/Fail 
P:   Tq Pass/Fail 
HHHHH:   Tq High Limit 
LLLLL:   Tq Low Limit 
TTTTT:  Tq Result 
P:   Angle Pass/Fail 
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HHHHH: Angle High Limit 
LLLLL: Angle Low Limit 
AAAAA: Angle Result 
NAC%: Msg End 
CR  
LF 
 
 
 
c) Standard Output with CR/LF 
 
Format: 
 
O P HHHHH LLLLL TTTTT P HHHHH LLLLL AAAAA 1 CR LF 
 
O:  Overall Pass/Fail 
P:   Tq Pass/Fail 
HHHHH:   Tq High Limit 
LLLLL:   Tq Low Limit 
TTTTT:  Tq Result 
P:   Angle Pass/Fail 
HHHHH: Angle High Limit 
LLLLL: Angle Low Limit 
AAAAA: Angle Result 
1:  PSet ( “1” – “9”) for PSets 1-9, (“A” – “W”) for PSets 10-32 
CR  
LF 
 
 
d) UEC Serial 
 
Format:  
 
# P 1 BB TTT.T AAAA 0000 0000 J 

(Notice that there is a decimal point next to the least significant T) 
 
P: parameter set ( “1” – “9”) for PSets 1-9, (“A” – “W”) for PSets 10-32 
B: batch count 
T: torque result 
A: angle result 
J: judgment (@=overall pass, H=low torque, I (eye)=hi torque, J=low 
angle, K=hi angle) 
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Statistics  
 

Minimum Stats - Number of rundowns that need to be performed before the 
statistics will be calculated and displayed on the controller. 

 
Stat Samples - Maximum number of rundowns used for calculating and displaying 
statistical data on the iEC controller. 
 
Statistical Outliers - The statistical outliers’ parameter is a code that is used to 
determine if the data from a rundown will be excluded from the data set being used 
in the static calculations that are displayed on the iEC controller. The exclusions are 
based on the results of the rundowns. 
The following are the codes for each exclusion type: 

2 - Final Torque Result Above High Limit 
4 - Final Torque Result Below Low Limit 
8 - Final Angle Result Above High Limit 
16 - Final Angle Result Below High Limit 
128 - Re-Hit 

 
To exclude any combination of the above list add up the code values.  
Example: To exclude all rundowns where the final torque was above the high limit 

(2) or the angle was below the low limit (16), Set the value for statistical 
outliers to 2 +16 = 18 

 
Lock on Reject 
When enabled, this prevents the tool from starting a new rundown if the result of the 
last rundown was a reject. 
The tool remains locked until reverse is selected on the tool or from the Logic IO 
Reverse Input. 
The Default setting is off. 
 
Batch Hold Reset 
Batch Control Reset Options for: “Disable Tool – Hold Count & Output Batch 
Complete” 
 
The following are options to re-enable the tool after it has been disabled in batch 
control:  

• Option 1: Re-enable the tool by toggling the RESET_BATCH Logic I/O input    
   (default). 
• Option 2: Re-enable the tool by selecting a new PSET or by toggling the 

RESET_BATCH input. (This option gives the operator that ability to manually 
re-enable the tool from the Controller front panel by pressing the CHANGE 
PSET button.) 

 
Low Speed Control Mode: 
Low Speed Control mode is designed to allow a tool to apply torque energy more 
consistently to a joint at lower RPM’s.  The feature precisely manages power delivery to 
the tool motor from the servo insuring the rotation of the fastener is done at a constant 
velocity even when the desired RPM is extremely slow.   
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IEC controllers are able to run this feature assuming the servo in the controller is REVB 
or higher and SCC code is 1.16 or higher. SCC installed code and Servo REV level is 
indicated each time the controller is powered on. This information is visible on the LED 
display.   
 
Controllers capable of Low Speed Control mode default to standard control unless 
selection of Low Speed Control is consciously made. Confirmation of Low Speed Control 
being in effect is shown in red type on the Parameter Set screen whenever it is in use.   
Low Speed Control is a feature that applies across all PSETs globally.  Selection of Low 
Speed Control ON or OFF requires a Power Cycling of the IEC control for the change to 
become effective.  Prompts will indicate to the user this requirement and the LED on the 
IEC controller will change to OFF indicating that a Power Cycle is required. 
 
While Low Speed Control has many benefits and is not inherently negative to tool 
performance when left in use, it does apply slightly higher power levels to the tool motor 
and in high duty cycle applications where it is not necessary, this feature should be 
turned off. 
 
Specific Information Related to Low Speed Control: 

• RPM range of tools when used with Low Speed Control activated is 4%-100% of 
the tool’s normal speed rating 

• Tubenut tools may not home accurately in Low Speed Control Mode. 
• Ergo Mode is not usable when using Low Speed Control 
• Low Speed Control is effective on all 1000 Series, 2000 Series and 3000 Series 

tools up to 90NM (larger tools are unable to use this feature) 
 
Disable Tool when SVC/CAL Due 

• Option to select(Default) – Disable tool in preset Service or Calibration period 
exceeded (date or time) LED warning appears on IEC Tool re-enabling 
accomplished by (to be determined) 

• Option de-selected – Tool remains enabled, LED warning appears on IEC 
 
Angle Count Configuration 

• This option determines when the angle count is started. Start angle count at 
threshold (default): The angle count is started when the tool crosses threshold 
torque, 

• Start angle count on throttle.: The angle count is started when the tool is 
activated. 

 
Gen 3 / 4 Buzzer and Headlight 
 
Buzzer ON -When enabled, the Buzzer serves two purposes: 
 

o In disassembly mode, the buzzer beeps. When a rundown is rejected the 
buzzer also beeps.  

 
o If a rundown is rejected, the beeping can be stopped by making a 

successful rundown or using the MFB option "Stop Reject Tone". 
 
Headlight ON -  Enables or Disables the Headlight. 
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2.6.3  Angle Offset Calibration 
Angle Calibration Value: 

• The value for this will determine how much to add or subtract to the angle 
measured and reported by the iEC controller. 

• The offset is added at the start of threshold. 
• The default value for this is 100. The range is 1 to 200. 
• The units are (value - 100) = degrees of correction. 
• Examples:  

• A value of 100 = No correction.  This is the default value.  
• A value of 90 = 10 degrees added to iEC angle measurement.  
• A value of 110 = 10 degrees subtracted from iEC angle measurement. 

Reset to Factory Calibration: The angle calibration value will be set to 100 = No 
correction. 

 
Angle Offset Calibration Routine: Toolware will automaticity calculate and send the 
angle 
offset calibration value to the controller. 
 

2.6.4 View/Edit Date Time 
Sets the date and time in the Controller 

 
 
2.6.5 Reset Controller to Defaults 

This option resets the Controller configuration to its factory default state.  
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2.7 Tool  
 

2.7.1 View 
Tool Parameters 

Reads all the tool parameters and displays on the screen 
 
Torque Cal Value  

Shows the current calibration value of the tool as well as the factory calibration 
 
RPM’s 
   Performing this test will determine the actual RPM of the tool. 
 
Cycle Count 

Displays the total number of rundowns on the tool good or bad 
 

2.7.2 Edit  
 
Tool Setup 
 
Each tool has a special parameter file that defines the tool. You can view the parameter 
file for that tool and how it differs from what is in the tool.  The tool Information such as 
Tool Id, Tool Model number, Tool cycle count and Tool Multiplier value are displayed. 
The User can change the Tubenut Parameters according to their application need and 
send it to the tool. 
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Figure 2.7.2 Tool Configuration and tubenut tool setup 
 
 
 
 
 
 
 
Multiplier - Configures the tool to include gearing added to the base model. 
Units: Gear Ratio * 100. 
a. Example: Adding a multiplier with a gear ratio of 5:1, Multiplier setting = 5. 
 
 
Obstruction Torque - In 1st 90° degrees of rotation in the tightening direction cycle will 
be aborted if this torque is exceeded. If the tool rotates 90° degrees and stops without 
any obstruction, the value is too low. 
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Open Loop - After reaching the open position, this open loop torque prevents the 
socket from bouncing to a partially closed position. This torque should be set to a value 
slightly less than the tube nut home torque. 
 
Home - In the reverse direction, reaching this torque indicates to the controller the 
socket is in the open position. If the socket does not attempt to return to the open 
position or returns at an extremely fast rate this value is too low. AcraDyne recommends 
starting at about 12 in-lbs. 
 
 

2.7.3 Calibrate 
 
Torque 
 
This is used to calibrate the tool.  Following are the steps that need to be followed to 
calibrate the Tool 
 

1. Press the “Start To Test” Button 
2. Run the Tool to Final Torque 
3. Put the External transducer value in the Measured Torque box. 
4. Press “Send to Tool” Button. 
5. The new Cal value is calculated automatically and assigned to the tool.  

 

 
 Figure 2.7.3 Tool calibration screen 
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Buttons and LED’s 
 
Calibrate Buttons - After a tool has been worked on, it is possible the relationship 
between hall sensors and magnet have changed.  Using the Tool Button Calibration 
screen calibrates the field between the two.  Test Trigger, Ccw, Center and Cw positions 
and send the values to the Tool. 
  
LED States - Turns the tool lights on, off, or flashes.  Used for testing of the Tool 
 

 
Figure 2.7.4 LED programming and button calibration 
 
 
Service and Calibration Log 
 
The Service Parameters are stored in the memory of the Tool and they can be viewed 
in this screen. The Next Service cycle or Next Service date in this screen will turn red if 
they exceed the value the service is due.  
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2.7.5 Tool Service and Calibration Log  
 

2.8 Rundowns 
Data for rundowns in all or selected Parameter Sets can be displayed in a tabular 
format. This information can then be saved as a “Ms.csv” File. 
 

• You can print the rundown results by using File ->Print in the menu. 
 

• Rundowns must be saved to a file before the statistics function can be used to 
evaluate the data. 

 
• Controller memory can be cleared by clicking the “Clear  iEC Rundown Memory” 

button 
 
2.8.1 Download Data 

 
• If rundown data is to be analyzed with the Statistics function, select All Data 
• If no statistical analysis is to be applied, select Results Only.  This will 

significantly decrease the time taken to download the data from the controller to 
the PC. 

 
 
2.8.2 Select Parameter Set 
 

• To view results of all saved rundowns, regardless of Parameter Set, select 
zero (0) 

• To view results of rundowns for a specific Parameter Set, select the 
appropriate Parameter Set number 
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• To select the columns you want to see, select custom and choose the 
columns from the selection menu 

• You can restrict the number of rundowns you want to see by selecting the 
Max. Rows (0 means all)  

• The Rundowns are ordered by latest first. So the Recent Rundown will be 
the first record to be downloaded.  You can stop download at any time and 
analyze the records that are downloaded.  

 
To begin rundown data download, click “Start Rundown Receive” 
 
Note: Statistics functionality requires “All Data” to be selected.  
 

 
Figure 2.8 Rundown Log example 

2.9  Log Info 
Log info describes the usage of the Controller and the tools that have been used 
with that controller.  
 
POR Counts - Number of times the controller power has been cycled. 
 
Controller Cycles - Number of rundown the controller has completed. 
 
Tool Log - Displays history of tools that have been previously connected to the 
controller. 
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Monthly Usage - Displays history of the number of rundowns the controller has 
performed divided into months and years. 
 
Note: Serial/Model number entries in usage log are abbreviated for functionality 
will legacy tools. 

 
Figure 2.9 Tool / controller Log Info example 
 
 
 

2.10  Statistics 
The statistics page takes a collection of final torque samples from a rundown file then 
calculates and displays statistical information about the collection. In addition, a 
histogram is plotted, and the final torque for each rundown is displayed graphically. The 
maximum number of rundowns that can be evaluated is 2048. If more data is stored in 
the file, then data for only first 2048 rundowns are used.  Torque values are displayed in 
the units shown on the Main Window toolbar. Rundown Files are saved using Toolware 
with *.MS.csv extension. This file type can be generated in the Rundowns page by 
receiving rundown data, then saving the data to a type *.MS.csv file. We can open this 
using the File -> Open option. 
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Figure 2.10 Statistics screen example 
 

PSet Selection (Parameter Set):  
a. Only rundowns with the PSet selected are used in the collection. In 

addition, Only Rundowns with settings for Torque High Limit, Torque Low 
Limit, and Target that match the first rundown are used in the collection. 

b. If 0 is selected for the PSet, all rundowns in the file will be used in the 
collection. 

 
Stats: 

• POP: Population; The total number of observations used to calculate the statistical 
data. 

• Mean: (Sum of All Readings) / (Number of Readings) 

•  CP: Overall capability, which is the ratio of 6 sigma to the tolerance.  The equation 
for CP is:      (Torque High Limit – Torque Low Limit) / 6 Sigma 

• CPK: Process capability, which takes both sigma and mean into account.  The 
equation for CPK is the smaller of:  (Torque High Limit – Mean) / 3 Sigma   or   
(Mean – Torque Low Limit) / 3 Sigma 

• 6 Sigma: The standard deviation multiplied by 6.  A total range of 6 sigma will 
include 99.7% of all data.  The equation for six sigma is as follows: 

 
6σ = 6 X  
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• Range: The difference between the maximum and minimum reading. 

• Min Tq: The maximum torque reading. 

• Max Tq: The minimum torque reading. 
 
 
Histogram of Final Torque Samples 
The histogram shows the frequency count of the number of times that a specified 
interval, or bin, occurs in the collection of final torque samples.  The range of the 
histogram is equally divided in to a specified number bins using the following equations: 

• The width  

• of the frequency bin is  

o  
o Where:  

 m is the selected Number of Bins. 
 max is the upper ceiling for the torque range to be evaluated 

(Range Ceiling) 
 min is the lower floor for the torque range to be evaluated  

(Range Floor)  

• The center points of each bin are set according to the following equation:  

o  
 
For reference, the Parameter Set values for Torque Hi, Torque Low, and Torque 
Target are taken from the first rundown in the collection and plotted as horizontal 
lines. 

Histogram adjustment:  
The width, center point, and number of bins can be adjusted by selecting 
different values for Range Ceiling, Range Floor and the Number of Bins. 

• Number of Bins Selection:  The histogram initially uses the number of 
rundowns in the collection for the number of bins. If there are more than 200 
rundowns, then the number of bins is set to 200. The number of bins can be 
adjusted from 2 to the number of rundowns + 1.  

• Range Ceiling Adjustment: This value is initially set to the maximum torque 
sample rounded up to the next higher integer.  This can be adjusted in 
increments of 0.1 

• Range Floor Adjustment: This value is initially set to the minimum torque 
sample rounded down to the next lower integer. This can be adjusted in 
increments of 0.1 
 Bin width and center points will be updated on a change to these values. 
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Final Torque Sample Graph 
The Final Torque Sample graph shows the final torque of each rundown in the 
collection.  
For reference, the Parameter Set values for Torque Hi, Torque Low, and Torque 
Target are taken from the first rundown in the collection and plotted as vertical lines. 
 

 
 

2.11  AcraVision  
AcraVision displays the current rundown information in an easy to read screen. If 

there is a failure in the tightening the Torque/Angle is displayed in red.  
 
Use Record Rundowns to save the Rundown information straight to the Computer 
memory.  You can use View saved rundowns to see the saved rundowns.  
 
 

 
Figure 2.11 AcraVision Screen example 
 
 

2.12  System  
 

2.12.1 Serial Test  
 Hyper-terminal like screen that can be used to monitor the serial output messages 
from the iEC controller  
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3. Addendum 

3.1 Fault codes  
Fault codes are displayed to inform the operator about what is happening in the 
Controller and why something doesn’t behave as expected.  

 
Figure Add.3.1 Fault Codes 
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3.2 Trouble Shooting 
Fault Description  
TID Timeout: No Communication between the tool and controller. This fault condition 
is usually caused by a problem in the tool ID board. Try connecting another tool to the 
controller 
  
Tool GND: The tool ground loop is broken. This fault condition is usually caused by a 
problem in the controller or tool. Try the tool and cable on another controller. The fault 
can be intermittent.  
  
Power on Throttle: The System thinks that the throttle is being activated or the run 
command through logic I/O is turned on. You can verify this by monitoring the tool 
buttons in Toolware. Make sure that the throttle is completely returning home 
completely after being released.  
 
Button Timeout: The button signals from the tool are not being received by the 
controller in a certain amount of time. Try connecting another tool to the system. 
 
Button State: An illegal light ring state has occurred. Two or more direction halls are 
enabled. You can verify this by monitoring buttons using ToolWare. Try recalibrating 
the buttons using ToolWare (CW, Center, and CCW or Trigger and MFB button 
Undefined Voltage: Either the controller voltage configuration or the tool voltage 
parameter are undefined. Try the tool on another system.  
 
Incompatible Voltage: The controller is not compatible with the tool.  
 
Illegal tool: A tubenut tool is connected to a system setup for multiples. 
 
Free Run Timeout: The tool has run for a period of time before seeing the threshold 
torque. The throttle must be released and pressed again before the tool will run 
again. This time is adjustable using ToolWare. The default value is 5 seconds.  
 
Load Run Timeout: The tool has run for a period of time after seeing the threshold 
torque. The throttle must be released and pressed again before the tool will run 
again. This time is adjustable using ToolWare. The default value is 15 seconds. 
 
Hall Error: The motor hall sensors (for commutation) have achieved an illegal state a 
specific number of times. If the tool does not run at all or the square drive has to be 
rotated before the tool will run the motor is probably damaged. Run this tool on a 
different controller to determine where the problem lies.  
 
Tool Offset: Based on the offset value of the transducer during re-zero and the tool 
cal value, the tool cannot mathematically reach the target torque. This problem can 
occur if the cal value has been drastically changed and the target torque in near the 
max torque of the tool. Try resetting the cal value to defaults and calibrating the tool 
using an approved rotary transducer.  
 
Tool Level: The tool transducer output voltage has exceeded the maximum or 
minimum allowable value. Try the tool on another system.  
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Locked rotor: The controller has not sensed hall transitions from the motor for a 
period of time. This is possible if the tool is trying to achieve a high torque at a low 
speed. Increase the rundown speeds and make sure the tool is calibrated properly. It 
is also possible that the controller is faulty. If the tool does not run at all try connecting 
it to a different controller.  
 
Drive Fault: The servo drive is not trying to run the tool. Try the tool on another 
controller.  
 
PSet Value: An illegal rundown parameter set has been sent to the controller. Try 
resetting the parameter sets back to factory defaults.  
 
 
TID Parameter Value: The tool sent an illegal parameter to the controller. Try cycling 
power to the system. Also, try the tool on another system.  
 
TID Parameter Timeout: The tool did not respond to a requested parameter for a 
period of time. Try cycling power to the system. Also, try the tool on another system.  
 
Target Value Fault: The target torque is set higher than the capacity of the tool. 
 
No Direction Hall: The tool was told to start running either from the throttle or 
through logic I/O but it wasn’t told what direction to go. Use ToolWare to monitor the 
buttons. Make sure the wiring to the I/O is correct if running the tool remotely.  
 
Xdcr Level: The tool transducer output voltage has exceeded the maximum or 
minimum allowable level.  

 

3.3 Tubenut Tool Setup Details 

Overview 
The following describes the setup required for tube-nut tool operation. This includes 
determining the values for tube-nut specific TID parameters (parameters residing in the 
tool memory) and iEC Controller parameters. 
 

3.3.1 Tube-Nut Homing  

Tube-Nut Home TID parameters: 
The tube-nut TID parameters can be viewed and modified from the Tool-> Edit->Tool 
Setup screen in ToolWare. The tool to be configured must be connected to the 
controller. 

• Home Detection Torque - Home  (in*Lb) 
o When the tool is homing, reaching this torque indicates to the controller 

the tool output socket has reached the home stop and is in the open 
position. 

o If the tool output does not attempt to return or does not completely reach 
the home position, this value is too low 
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o Attention: Setting this value too high can potentially damage the tool. 
o Units: lbf-in 
o TID memory location: 53 

• Hold at Home Torque - Open Loop (in*Lb) 
o After reaching the home position, this torque is applied against the home 

stop to prevent the socket from bouncing to a partially closed position.  
o This value is typically set to a value slightly lower than the home detection 

torque. 
o If the socket is bouncing back to a partially closed position after reaching 

the home stop, this value is too low. 
o Attention: Setting this value too high can cause the socket to snap 

back to the home stop too quickly and potentially damage the tool.  
o Units: lbf-in (approximation) 
o TID memory location: 54 

Typical Procedure for setting the tool’s Tubenut Home TID Parameters 
• Set the Hold at Home Torque = 0 
• Set the  Home Detection Torque = 1 
• Free run the tool and watch the homing routine while making the adjustments 

below. 
• Gradually increase the value for the Home Detection Torque until the tool reliably 

returns to the home position. 
• Once a good value for the Home Detection Torque is found, if the tool is 

bouncing back to a partially closed position after hitting the home stop. 
o Gradually increase the value for the Hold at Home Torque until bounce 

back is eliminated. 

Controller parameters affecting tube-nut homing: 
Controller parameters for tube-nut operation can be viewed and modified from the 
Controller->Edit Controller Parameter->Tube-nut screen in ToolWare. 

• Tube-Nut Backoff Speed: 
o This is the speed the tool output socket travels when returning to the 

home position. 
o Decreasing this can reduce the impact force when hitting the home stop.  
o Attention: Care must be taken, increasing the speed above the 

default value. Too high of a value can greatly increase how hard the 
output will hit the home stop and potentially damage the tool.  

o Units: RPM of the tool output socket in the homing direction 
o Default value: 100 RPM.  
o Range: 10 to 500 RPM 

• Tube-Nut Homing Reverse Dwell Time: 
o The amount of time before the output is allowed to home, after the 

rundown is complete and the tool lever is released. 
o Units: Seconds 
o Default value: 0.5 Seconds 
o Range: 0 to 2 Seconds 
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• Tube-Nut Home Dwell time: 
o The amount of time the tool holds at home to prevent bounce back 
o Too short of home dwell time can increase the occurrence of bounce 

back. However, decreasing the homing speed can decrease the severity 
of bounce back after the home stop is reached and allow for a shorter 
dwell time. 

o Units: Seconds 
o Default value: 0.5 Seconds 
o Range: 0 to 2 Seconds 

 

3.3.2 Tube Nut Pinch Detection 

Tube-Nut Home TID parameters: 
The tube-nut TID parameters can be viewed and modified from the Tool-> Edit->Tool 
Setup screen in ToolWare. The tool to be configured must be connected to the 
controller. 

• Obstruction Detection Torque -  (in*Lb) 
o At the start of rundown before the output rotation has passed though the 

Obstruction Check Zone (where the output is open at the start of the 
fasting cycle), the tool will stop and fastening cycle will be aborted if this 
torque is exceeded. 

o If the tool stops, when the output is open during this first part of the 
rundown, without any obstruction, the value is too low. 

o Units: lbf-in 
o TID memory location: 53 

Typical Procedure for setting the tool’s Tubenut obstruction detection 
parameters: 

• Set the value for the obstruction torque just high enough so the tool will reliably 
overcome gear friction and make it past the obstruction checking zone. 

• Check the torque of the stop on obstruction feature by measuring the actual 
“pinch” torque the tube nut produces at the start of the rundown when the jaws 
are open (within the obstruction detection angle range). This can be done on a 
semi-tightened joint simulator set for a hard joint, while auditing the torque. 

• Note: Gear friction in the tube-nut head can greatly affect the ability to reliably 
detect an obstruction. 

Controller parameters affecting tube nut pinch detection. 
Controller parameters for soft-start operation can be viewed and modified from the 
Controller->Edit Controller Parameter->Soft Start in ToolWare. 

• Soft Start Dwell Speed 
o The Soft Start Dwell Speed is used during the check for obstructions. 
o Decreasing this can reduce the impact force when hitting an obstruction.  
o Attention: Care must be taken, increasing the speed above the 

default value. Too high of a value can greatly increase how hard the 
output will hit the obstruction. 
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o Units: RPM of the tool output 
o Default: 90 RPM 
o Range: 1 to 500 RPM 

 

3.3.3 Tube-Nut Homing Start Input Logic Selection 
The controller parameters for tube- operation can be viewed and modified from the 
Controller->Edit Controller Parameter->Tube-nut screen in ToolWare. 

• Tube-nut Home Strategy: 
o Lever action required to start the home sequence. 
o Options: 

 Home on release and repress of the lever (default) 
 Home on release of the lever 
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